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C H A P T E R  1  

Introduction 

This chapter provides basic information about Parallels Transporter® and this Guide. 

In This Chapter 
About Parallels Transporter .................................................................................................. 5 
About This Guide.................................................................................................................. 6 
Getting Help.......................................................................................................................... 8 
Feedback ............................................................................................................................... 8
 
 

About Parallels Transporter 
Parallels Transporter enables you to migrate selected volumes or the whole of a physical or 
virtual computer into a Parallels virtual machine or Parallels virtual disk. 

The Parallels Transporter package includes two applications: Parallels Transporter and Parallels 
Transporter Agent. 

 Parallels Transporter is an application that transfers data stored on a physical computer or a 
volume to a Parallels virtual machine or virtual hard disk. 

 Parallels Transporter Agent is a Parallels Transporter utility that collects essential system 
data on the remote computer (the source computer) or volume you are planning to migrate 
and transfers it to Parallels Transporter installed on the computer that will host the resulting 
virtual machine or virtual hard disk (the host computer). 

The package should be installed both on the host computer, to perform migration, and on the 
physical source computer, to collect source system data and transfer it to Parallels Transporter. 
Parallels Transporter can be installed together with Parallels Desktop, Parallels Server, or 
Parallels Workstation (the main application) or using the installation file that is available from 
Parallels Download Center (http://www.parallels.com/en/download/desktop/) (standalone 
Parallels Transporter). 
 

 

http://www.parallels.com/en/download/desktop/
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About This Guide 
This Guide is aimed at a wide range of users who want to use Parallels Transporter to create 
Parallels virtual machines or Parallels virtual hard disks based on the data collected from 
physical computers or some of their volumes and third-party virtual machines. The guide 
provides both high-level concept descriptions and detailed step-by-step instructions to help you 
learn the product quickly and easily. 

Abbreviations used in the text 

In the present guide the following abbreviations are used: 

 OS  is used instead of operating system in long sentences where using it will not change the 
meaning of the sentence. 

 VM is used instead of virtual machine  in long sentences where using it will not change the 
meaning of the sentence. 

Help Usage Tips 

Use the icons in the upper part of the help window to: 

 go to the online documentation page 
 contact the Parallels support team 

To print a help page, click the Print icon . If this doesn't work, right-click the Print icon and 
choose Print Frame. 
 

Organization of This Guide 
The present guide comprises the following chapters: 

 Introduction (p. 5). Provides basic information about the product and this guide. 
 System Requirements (p. 9). Provides information about the system requirements the 

computer(s) should meet to ensure successful installation and work of the product. 
 Installing Parallels Transporter (p. 17). Provides detailed instructions on product installation 

and deinstallation. 
 Migration Process Overview (p. 23). Provides information on basic Parallels Transporter 

notions. 
 Working With Parallels Transporter (p. 30). Provides typical migration scenarios and 

instructions on how to perform them. 
 Troubleshooting and Limitations (p. 73). Provides the solutions for the known issues. 
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Documentation Conventions 
Before you start using this guide, it is important to understand the documentation conventions 
used in it. 

The table below presents the existing formatting conventions. 

Formatting convention Type of Information Example 
Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the Resources tab.  
Special Bold 
 Titles of chapters, sections, and 

subsections. 
Read the Basic Administration chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to designate 
a command line placeholder, 
which is to be replaced with a 
real name or value. 

These are the so-called EZ templates. 

To destroy a Container, type vzctl 
destroy ctid. 

Monospace The names of commands, files, 
and directories. 

Use vzctl start to start a 
Container. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

Saved parameters for Container 
101 

Monospace Bold What you type, as contrasted 
with on-screen computer 
output. 

# rpm –V virtuozzo-release 

Key+Key Key combinations for which 
the user must press and hold 
down one key and then press 
another. 

Ctrl+P, Alt+F4 

Besides the formatting conventions, you should also know about the document organization 
convention applied to Parallels documents: chapters in all guides are divided into sections, 
which, in their turn, are subdivided into subsections. For example, About This Guide is a section, 
and Documentation Conventions is a subsection. 
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Getting Help 
Parallels Transporter offers several options for accessing necessary information. 

In all host OSs: 

 Help buttons. Click the  Help button at the bottom of the Transporter window to open a 
corresponding help page. 

 Parallels Transporter User's Guide. This document contains extensive information about the 
product, its usage, and troubleshooting. The PDF version of this guide can be accessed from 
the main application (Parallels Desktop, Parallels Server, or Parallels Workstation) Help 
menu > Online Documentation. 

 Parallels website (http://www.parallels.com). Explore the Support web page that includes 
product help files and FAQ section. 

 Parallels Knowledge Base (http://kb.parallels.com/). This online resource comprizes 
valuable articles about using Parallels Transporter and other Parallels products. 

In Mac OS X: 

 Help files for Parallels Transporter available through the Help menu > Parallels Transporter 
Help. 

 

Feedback 
If you spot a typo in this guide, or if you have thought of a way to make this guide better, we 
would love to hear from you! 

The ideal place for your comments and suggestions is the Parallels documentation feedback 
page (http://www.parallels.com/en/support/usersdoc/). 

 
 

http://www.parallels.com/
http://kb.parallels.com/
http://www.parallels.com/en/support/usersdoc/


 9 
 

 

C H A P T E R  2  

System Requirements 

This chapter lists system and network requirements. Before you start migrating, make sure that 
your host and source computers meet these requirements. If you are migrating locally, your 
computer must comply with both host and source computer requirements. 

In This Chapter 
Host Computer System Requirements .................................................................................. 9 
Source Computer System Requirements............................................................................... 12 
Network Requirements ......................................................................................................... 16
 
 

Host Computer System 
Requirements 

Parallels Transporter can be installed on a computer that has a Mac OS X, Windows, or Linux 
operating system installed. The computer that will host the resulting virtual machines and virtual 
hard disks (the host computer) must comply with the system requirements listed in this section. 

Note: To be able to run Parallels virtual machines on your host computer, you should install 
Parallels Desktop, or Parallels Server, or Parallels Workstation on it. For detailed information 
how to do it, see the user's guide of the corrsponding application. 
 

Mac OS X Computers 
In Mac OS X, Parallels Transporter can be installed automatically with Parallels Desktop or 
Parallels Server. To ensure the Parallels Transporter successful installation and proper 
functioning, your host computer should comply with the system requirements of the 
corresponding product. You can find the Parallels Desktop system requirements in Parallels 
Desktop User's Guide and the Parallels Server system requirements in Parallels Server 
Administration Guide. 
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Windows Computers 
In Windows, the Parallels Transporter package is installed together with Parallels Workstation 
or using the installation file that is available from Parallels Download Center 
(http://www.parallels.com/en/download/desktop/). If you install the application together with 
Parallels Workstation, your host computer should comply with the system requirements of 
Parallels Workstation. You can find the Parallels Workstation system requirements in Parallels 
Workstation User's Guide. If you install the standalone Parallels Transporter package 
downloaded from the Parallels website, this computer must comply with the following 
requirements. 

Hardware Requirements 
 700+ MHz x86 (32-bit) or x64 (64-bit) processor (Intel or AMD). 
 768 MB RAM minimum. 1 GB RAM is recommended. 
 25 MB of hard disk space is required for the installation of Parallels Transporter package. 

15 GB of hard disk space is recommended for each of the resulting virtual machines or 
virtual hard disks. 

 CD-ROM or DVD-ROM drive (optional). 
 Ethernet or WiFi network adapter. 

Software Requirements 
 Windows Vista® Ultimate, Enterprise, Business 
 Windows Server® 2003 Standard Edition SP0, SP1 
 Windows Server 2003 Enterprise Edition SP0, SP1 
 Windows Server 2003 Web Edition SP0, SP1 
 Windows XP Professional SP0, SP1,SP2 
 Windows XP Home  SP0, SP1,SP2 
 Windows 2000 Professional Edition 
 Windows 2000 Server 
 Windows 2000 Advanced Server 

 

 

http://www.parallels.com/en/download/desktop/
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Linux Computers 
In Linux, the Parallels Transporter package is installed together with Parallels Workstation or 
using the installation file that is available from Parallels Download Center 
(http://www.parallels.com/en/download/desktop/). If you install the application together with 
Parallels Workstation, your host computer should comply with the system requirements of 
Parallels Workstation. You can find the Parallels Workstation system requirements in Parallels 
Workstation User's Guide. If you install the standalone Parallels Transporter package 
downloaded from the Parallels website, this computer must comply with the following 
requirements. 

Hardware Requirements 
 700+ MHz x86 (32-bit) or x64 (64-bit) processor (Intel or AMD). 
 768 MB RAM minimum. 1 GB RAM is recommended. 
 25 MB of hard disk space is required for the installation of Parallels Transporter package. 

15 GB of hard disk space is recommended for each of the resulting virtual machines or 
virtual hard disks. 

 CD-ROM or DVD-ROM drive (optional). 
 Ethernet or WiFi network adapter. 

Software Requirements 
 Red Hat® Enterprise Linux 5, 4 
 Debian® Linux 4.0 
 Fedora™ Core Linux  6, 5, 4; Fedora™ 8, 7 
 SUSE® Linux 10.3, 10.2, 10.1, 10.0, 9.3 
 Mandriva Linux 2008, 2007 
 Ubuntu® Linux 7.10, 7.04, 6.10, 6.04, 5.04 

To successfully install Parallels Transporter and its components, make sure you have the 
following software on your Linux computer: 

 GNU Compiler 4.0 or higher 
 GNU Make 3.8 or higher 
 kernel 2.6.14 source files or development package 
 glibc 2.3.6 
 glib2 2.10.3 
 glib 2.3.6 
 zlib 1.2.2.2 
 libstdc++ 4.0.2 
 libpng 1.2.8 

 

 

http://www.parallels.com/en/download/desktop/
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Source Computer System 
Requirements 

Parallels Transporter enables you to migrate from physical and virtual computers. Computers of 
each type must comply with specific system requirements. Before you start migrating, make 
sure that your source computer meets the requirements listed in this section. 
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Physical Computer 
To migrate data from a physical computer, you need to install Parallels Transporter Agent in it. 
Parallels Transporter Agent collects the information about the source computer and transfers it 
to Parallels Transporter for processing. 

Parallels Transporter Agent can be installed with the Parallels Transporter package available 
from Parallels Download Center (http://www.parallels.com/en/download/desktop/). It supports 
computers with a Windows or Linuxoperating system installed. To ensure the performance of 
Parallels Transporter Agent, your computer must comply with the following requirements. 

Hardware Requirements 
 700+ MHz x86 (32-bit) or x64 (64-bit) processor (Intel or AMD). 
 256 MB RAM minimum. 
 25 MB of hard disk space is required for the installation of Parallels Transporter package. 

15 GB of hard disk space is recommended for each of the resulting virtual machines or 
virtual hard disks. 

 CD-ROM or DVD-ROM drive (optional). 
 Ethernet or WiFi network adapter. 

Software Requirements 

Parallels Transporter supports the following operating systems: 

 Windows Vista® Ultimate, Enterprise, Business 
 Windows Server® 2003 Standard Edition SP0, SP1 
 Windows Server 2003 Enterprise Edition SP0, SP1 
 Windows Server 2003 Web Edition SP0, SP1 
 Windows XP Professional SP0, SP1,SP2 
 Windows XP Home  SP0, SP1,SP2 
 Windows 2000 Professional Edition 
 Windows 2000 Server 
 Windows 2000 Advanced Server 

Parallels Transporter supports the following Linux operating systems: 

 Red Hat® Enterprise Linux 5, 4 
 Debian® Linux 4.0 
 Fedora™ Core Linux  6, 5, 4; Fedora™ 8, 7 
 SUSE® Linux 10.3, 10.2, 10.1, 10.0, 9.3 
 Mandriva Linux 2008, 2007 
 Ubuntu® Linux 7.10, 7.04, 6.10, 6.04, 5.04 

Supported File Systems 

Parallels Transporter supports the following file systems: 

 FAT16/32 (Windows only) 

 

http://www.parallels.com/en/download/desktop/


 System Requirements 14 
 

 NTFS (Windows only) 
 Ext2/Ext3 

Parallels Transporter does not support migrating Windows dynamic volumes and Linux logical 
volumes (LVM). 

If the file system is not supported, Transporter copies all disk sectors successively. 
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Virtual Computer 
Parallels Transporter enables you to migrate from a VMware, Microsoft Virtual PC, or 
VirtualBox virtual machine or virtual disk to a Parallels virtual machine or virtual disk. The 
source computer or disk must meet the listed requirements, so that Parallels Transporter can 
function properly. 

Supported Formats of Virtual Computer Files 

Parallels Transporter supports virtual machines and disks created in the following products: 

 VMware Fusion 1.1, 2.0 
 VMware Workstation 5.5, 6.0 
 VMware ESX Server 3.5 
 Microsoft Virtual PC (for Mac) 7.0 
 Microsoft Virtual PC (for Windows) 2007 
 Microsoft Virtual Server 2005 
 Sun Microsystems VirtualBox 1.6.1, 2.0.4 

Virtual machines created in other versions of these products haven't been extensively tested. 

Software Requirements 

Parallels Transporter supports the following operating systems: 

 Windows Vista® Ultimate, Enterprise, Business 
 Windows Server® 2003 Standard Edition SP0, SP1 
 Windows Server 2003 Enterprise Edition SP0, SP1 
 Windows Server 2003 Web Edition SP0, SP1 
 Windows XP Professional SP0, SP1,SP2 
 Windows XP Home  SP0, SP1,SP2 
 Windows 2000 Professional Edition 
 Windows 2000 Server 
 Windows 2000 Advanced Server 

Parallels Transporter supports the following Linux operating systems: 

 Red Hat® Enterprise Linux 5, 4 
 Debian® Linux 4.0 
 Fedora™ Core Linux  6, 5, 4; Fedora™ 8, 7 
 SUSE® Linux 10.3, 10.2, 10.1, 10.0, 9.3 
 Mandriva Linux 2008, 2007 
 Ubuntu® Linux 7.10, 7.04, 6.10, 6.04, 5.04 

Supported File Systems 

Parallels Transporter supports the following file systems: 
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 FAT16/32 (Windows only) 
 NTFS (Windows only) 
 Ext2/Ext3 

Parallels Transporter does not support migrating Windows dynamic volumes and Linux logical 
volumes (LVM). 

If the file system is not supported, Transporter copies all disk sectors successively. 
 

Network Requirements 
To migrate from a remote computer, you need to establish a network connection between the 
host and the source computers. The connection can be wireless or wired. If you use a wired 
connection with default settings, Parallels Transporter automatically configures the connection 
settings. If you changed the default settings or use a wireless connection, you need to configure 
the settings manually. 

Note: For all connections, Parallels Transporter uses fixed ports in the range of 1620 to 1623. 
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C H A P T E R  3  

Installing Parallels Transporter 

This chapter provides instructions on installing Parallels Transporter. 

In This Chapter 
Installing on Mac OS X......................................................................................................... 17 
Installing on Windows .......................................................................................................... 18 
Installing on Linux ................................................................................................................ 21 
Removing Parallels Transporter............................................................................................ 21
 
 

Installing on Mac OS X 
Parallels Transporter is installed automatically if you install Parallels Desktop or Parallels 
Server.  

In both cases, Parallels Transporter is placed to the following folder: 
/Applications/Parallels. 

For the detailed instructions on installing Parallels Desktop, refer to Parallels Desktop User's 
Guide. 

For the detailed information on installing Parallels Server, refer to Parallels Server Installation 
Guide for Mac. 
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Installing on Windows 
If you have Parallels Workstation installed on your Windows computer, Parallels Transporter is 
installed automatically with it. 

If you do not want to install Parallels Workstation on your Windows computer, you can also 
install a separate package containing Parallels Transporter and Parallels Transporter Agent (this 
utility is required for the remote migration). You can download the most recent version of the 
Parallels Transporter package from Parallels Download Center 
(http://www.parallels.com/en/download/desktop/). 

Note: You must have administrator rights to install the Parallels Transporter package. 

The Parallels Transporter package contains Parallels Transporter and Parallels Transporter 
Agent which are installed simultaneously during Parallels Transporter installation. 

Installing the Parallels Transporter package 
1 Open the  ParallelsTransporter-parallels-en_US-xxxx.xxxxxx.exe to 

start installation. 

The Parallels Transporter Agent Setup Wizard displays the Welcome window. Click Next. 
2 In the License Agreement window, carefully read End User License Agreement. Click the 

Print button to print the document. If you agree with the stated terms and conditions, select I 
accept the terms in the license agreement. Click Next.  

 

 

http://www.parallels.com/en/download/desktop/
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3 In the Setup Type window select the type of installation: 

 If you select the Complete type of installation, both Parallels Transporter and Parallels 
Transporter Agent will be installed. 

 If you select the Custom type of installation, you will be able to choose if you want to 
install Parallels Transporter Agent only or the full package. 

Click Next. 

 

 



 Installing Parallels Transporter 20 
 

4 If you selected the Complete type of installation, go to step 5. 

If you selected the Custom type of installation, choose what components you want to install. 
To change the Parallels Transporter destination folder, click the Change button and browse 
to another location. To see the disk space required for the installtion of the selected 
components, click the Space button. Click Next. 

 
5 Click Install on the Ready to Install the Program screen to start the installation. 

6 The wizard informs you about the successful installation with the Setup Wizard Completed 
screen. Click Finish to exit the wizard. 
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Installing on Linux 
If you have Parallels Workstation installed on your Linux computer, Parallels Transporter is 
installed automatically with it. 

If you do not want to install Parallels Workstation on your Linux computer, you can also install 
a separate package containing Parallels Transporter and Parallels Transporter Agent (this utility 
is required for the remote migration). You can download the most recent version of the Parallels 
Transporter package from Parallels Download Center 
(http://www.parallels.com/en/download/desktop/). 

Note: You must have root privileges to install the Parallels Transporter package in Linux. 

Installing the Parallels Transporter package 
1 Double-click the downloaded RUN file. 

2 In the introduction window, select Next and press Enter. 

3 Carefully read the license agreement. If you agree with the terms of the licence agreement, 
select Accept and press Enter. This will install Parallels Transporter and Parallels 
Transporter Agent on this computer. 

Note: Choosing Decline terminates the installation. 

4 When the Parallels Transporter components are successfully installed, select Exit and press 
Enter to complete the installation. 

 

Removing Parallels Transporter 
This chapter provides instructions on removing Parallels Transporter and its components. 
 

Removing From Mac OS X 
In Mac OS X, Parallels Transporter can be removed along with the product it was installed with 
(Parallels Desktop or Parallels Server). For the instructions on removing Parallels Desktop, see 
Parallels Desktop User's Guide. For the instructions on removing Parallels Server, see Parallels 
Server Installation Guide for Mac. 

 
 

 

http://www.parallels.com/en/download/desktop/
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Removing From Windows 
If you installed Parallels Transporter on your Windows computer together with Parallels 
Workstation, it can be removed along with Parallels Workstation. For the instructions on 
removing Parallels Workstation, see Parallels Workstation User's Guide. 

If you installed Parallels Transporter together with Parallels Transporter Agent as a separate 
package, it can be removed in two ways: 

 From the Start menu, choose Control Panel > Add or Remove Programs. Select Parallels 
Transporter in the programs list and click Remove, or 

 Open the file ParallelsTransporter-parallels-en_US-xxxx.xxxxxx.exe. 
This will start the Setup Wizard that will remove the program. 

Note: You must have administrator rights to remove Parallels Transporter. 
 

Removing From Linux 
If you installed Parallels Transporter on your Linux computer together with Parallels 
Workstation, it can be removed along with Parallels Workstation. For the instructions on 
removing Parallels Workstation, see Parallels Workstation User's Guide. 

If you installed Parallels Transporter together with Parallels Transporter Agent as a separate 
package, it can be removed through the RUN file you used to install Parallels Transporter. For 
information about accessing this RUN file, refer to Installing on Linux (p. 21). 

To remove Parallels Transporter 
1 Double-click the downloaded RUN file. 

2 In the introduction window, select Next and press Enter. 

3 In the next window, select Remove and press Enter. 

4 When the Parallels Transporter components are successfully removed, select Exit and press 
Enter to close the wizard. 
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C H A P T E R  4  

Migration Process Overview 

This chapter provides information about the basic steps of migrating data with Parallels 
Transporter. 

In This Chapter 
Initiating Migration ............................................................................................................... 24 
Deciding on Migration Mode................................................................................................ 25 
Choosing Migration Type ..................................................................................................... 26 
Defining Connection Type.................................................................................................... 26 
Specifying Migration Source ................................................................................................ 27 
Configuring Operating System ............................................................................................. 27 
Defining the Virtual Machine Name and Location............................................................... 28 
Specifying Destination Folder............................................................................................... 29 
Finishing Migration............................................................................................................... 29
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Initiating Migration 
Before migrating a computer, a third-party virtual machine, or a virtual disk to a Parallels virtual 
machine, you should open Parallels Transporter on the computer which will store the resulting 
virtual machine. If you are migrating data from a remote computer, you should open Parallels 
Transporter Agent on the remote computer before starting the migration. 

Starting Parallels Transporter 

To start Parallels Transporter in Mac OS X: 

1 In the Finder, open the /Applications/Parallels/ folder. 

2 Double-click the Parallels Transporter application. 

To start Parallels Transporter in Windows: 

 If Parallels Transporter was installed together with Parallels Workstation, click the 
Windows Start menu and choose All Programs > Parallels > Parallels Workstation > Parallels 
Transporter or choose Run Parallels Transporter from the Parallels Workstation File menu. 

 If Parallels Transporter was installed as a separate package, click the Windows Start menu 
and choose All Programs > Parallels > Parallels Transporter. 

Note: You may need to start Parallels Transporter on a remote Windows computer to migrate 
the computer locally. For more information about this type of migration, refer to Migrating 
From a Remote Computer (p. 36). 

To start Parallels Transporter in Linux, click the Applications menu and choose System Tools > 
Parallels Transporter. 

Note: You may need to start Parallels Transporter on a remote Linux computer to migrate the 
computer locally. For more information about this type of migration, refer to Migrating From a 
Remote Computer (p. 36). 

Starting Parallels Transporter Agent 

To start Parallels Transporter Agent in Windows, click the Windows Start menu and choose All 
Programs > Parallels > Parallels Transporter Agent. 

To start Parallels Transporter Agent in Linux, click the Applications menu and choose System 
Tools > Parallels Transporter Agent . 

Note: While Parallels Transporter Agent is open, the Windows computer won't switch to sleep 
mode. 
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Deciding on Migration Mode 
Parallels Transporter can run in two modes: Express and Advanced. The basic difference 
between the two is the degree of user control over the process. The Advanced mode offers a 
more flexible environment, while the Express mode enables you to concentrate on the migration 
object, not on the migration method. 

Express Mode 

In the Express mode, Parallels Transporter uses predefined settings to migrate from the active 
physical volume or virtual volume. By default, Parallels Transporter applies hardware changes 
to the source operating system to make it bootable with Parallels virtual machine. If the 
migration was completed successfully, Parallels Transporter creates two files: a virtual machine 
configuration file (.pvs) and a virtual hard disk file (.hdd). If Parallels Transporter cannot 
find the system files required for applying the necessary hardware changes, the source volume is 
migrated as a Parallels virtual hard disk. 

Destination folder and file names are predefined. For details, see Defining Virtual Machine 
Name and Location (p. 28). 

Advanced Mode 

In the Advanced mode, Parallels Transporter uses the settings specified by the user. You can 
customize the migration settings in the following way: 

 Select the specified remote or host source computer volumes you want to migrate. 
 Select the type of migration output: a bootable virtual machine hard disk or a virtual data 

disk. 
 Specify the destination folder and the resulting virtual machine or virtual hard disk name. 

Upon migration, Parallels Transporter creates several files depending on the desired migration 
output and specified source. For example, if you migrate from several source disks to a Parallels 
virtual machine, Parallels Transporter creates a virtual machine configuration file (.pvs) and 
several virtual hard disk files (.hdd). All virtual hard disks are accessible from the resulting 
virtual machine. 
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Choosing Migration Type 
Parallels Transporter can be used to migrate data from a physical or virtual computer. You can 
select the necessary migration source in the Migration Source Type window: 

 Select Remote physical computer to migrate data from the selected volumes of a remote 
physical computer. For details, see Migrating From a Remote Computer (p. 36). 

 Select Virtual machine to migrate data from a VMware, Microsoft Virtual PC, or VirtualBox 
virtual machine. Using this option, you can also convert a Parallels or a third-party virtual 
disk to a Parallels virtual machine. For details, see Migrating From a Virtual Computer (p. 64). 

 If you launch the standalone Parallels Transporter application (downloaded from the 
Parallels website) on a Windows or Linux physical computer, you will be able to select 
Local physical computer to migrate data from the selected volumes of this Windows or 
Linux physical computer to a virtual machine whose files are saved on the same computer. 
Then you will be able to transfer these files manually to the host computer where Parallels 
Desktop, Parallels Server, or Parallels Workstation is installed. For details, see Migrating 
From a Remote Computer Locally (p. 58). 

Note: If you want to migrate from the Boot Camp partition locally, choose Local physical 
computer. 
 

Defining Connection Type 
The connection between your computer and the source computer can be established through: 

 network connection 
 FireWire cable 

You can choose either type of connection, though it is recommended to use the first, since it 
usually requires less effort. You can specify the type of connection you use in the Connection 
Type window. 

 Network connection. Select this option if both computers are connected to the same network. 
If you select this option, Parallels Transporter will automatically detect the source computer 
that has Parallels Transporter Agent running and prepare to receive data from it. 

Note: If Parallels Transporter Agent is not running on the source computer, Parallels 
Transporter will be unable to detect it. 

 FireWire. Select this option if the computers are connected by a FireWire cable. 
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Specifying Migration Source 
Parallels Transporter can be used to migrate data from several types of sources: 

 remote physical computer 
 remote physical hard disk or one of its volumes 
 Boot Camp partition (for using in Parallels Desktop or Parallels Server in Mac OS X) 
 third-party virtual machine or its virtual hard disk 

Note: Before migrating a third-party virtual machine, you need to remove virtualization utilities 
from it. For detailed information, see the Removing Third-Party Virtualization Tools (p. 74) 
section. 

If Parallels Transporter is installed on a computer with a Windows or Linux operating system, 
you can also migrate data from this computer to a Parallels virtual machine or virtual hard disk. 
To be able to use the resulting virtual machine or virtual hard disk in your main working 
application, you will need to transfer its files from the source computer to the computer where 
your main application is installed. 
 

Configuring Operating System 
After you have specified the migration source, you should choose whether you want to transfer 
the source data to a new virtual machine or to a virtual data disk. 

In the Hard Disk Role window, specify the operation you are planning to perform with the 
migrated disk: 

 Bootable disk, or 
 Data disk 

If one of the volumes you selected for migration has an operating system installed, it is 
recommended to select the Bootable disk option. Selecting this option enables Parallels 
Transporter to create a new virtual machine and apply the necessary hardware changes to the 
operating system installed on one of the selected volumes, so that you can use it as a virtual 
machine's boot disk. 

If the volumes you selected contain data only, it is recommended to select the Data disk option. 
Selecting this option enables Parallels Transporter to migrate them as data disks. If you select 
this option, Parallels Transporter won't create a virtual machine from this disk. 
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Defining the Virtual Machine Name 
and Location 

If you have chosen to transfer data to a virtual machine, you should specify the virtual machine 
name and choose a location for its folder. 

Note: Before specifying the location, make sure there is enough free space on the destination 
volume. 

By default, the virtual machine is named according to the migration source, but you may specify 
another name. 

 If you migrate from a physical computer, the folder is named after the source operating 
system by default. 

 If you migrate from a virtual computer, the folder is named after the source virtual disk by 
default. 

The default location for the virtual machine's folder depends on the operating system of the 
physical computer: 

 In Mac OS X: /<username>/Documents/Parallels/. 
 In Windows: C:\Documents and Settings\<username>\My 
Documents\Parallels\. 

 In Linux: /<Home>/parallels/. 

To specify the resulting virtual machine name and path, use the Virtual Machine Name window. 
You may type the path to the destination folder or use the Choose button to locate the folder. 
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Specifying Destination Folder 
If you are migrating a physical volume or a third-party virtual hard disk to a non-bootable 
Parallels data disk, you should choose a location for the resulting virtual hard disk. 

Note: Before specifying the location, make sure there is enough free space on the destination 
volume. 

The default location for the resulting virtual hard disk depends on the operating system of the 
physical computer: 

 In Mac OS X: /<username>/Documents/Parallels/. 
 In Windows: C:\Documents and Settings\<username>\My 
Documents\Parallels\. 

 In Linux: /<Home>/parallels/. 

Note: If you specify another path that is not the absolute path, the resulting virtual hard disk will 
be saved to the folder in which Parallels Transporter was launched. 

To specify the path to the destination folder, use the Destination Folder window. You may type 
the path to the destination folder or use the Choose button to locate the folder. 
 

Finishing Migration 
Parallels Transporter informs you about successful migration with the Migration Complete 
window. 

If Parallels Desktop, Parallels Server, or Parallels Workstation is installed on your computer and 
you want to add the resulting virtual machine to the corresponding application list of the 
registered virtual machines, select the Open the virtual machine in <Product Name> option. If you 
leave this option disabled, the resulting virtual machine folder will open. 

Note: If neither of these applications is installed on this computer, the Open the virtual machine 
in <Product Name> option is not offered. 

Click Finish to quit Parallels Transporter. 
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C H A P T E R  5  

Working With Parallels Transporter 

This chapter provides descriptions of Parallels Transporter typical usage scenarios and detailed 
instructions on the migration process. 

In This Chapter 
Typical Usage Scenarios ....................................................................................................... 30 
Migrating With Parallels Transporter ................................................................................... 36
 
 

Typical Usage Scenarios 
Parallels Transporter can be used in several different ways depending on the purpose of 
migration. This section provides an overview of  Parallels Transporter usage scenarios. For 
detailed instructions on how to accomplish the scenarios, see Migrating With Parallels 
Transporter (p. 36). 
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Migrating Over Network (Remote Migration) 
In this type of migration, the source computer (whose data you want to migrate to a virtual 
machine) and the computer that will host the resulting virtual machine are connected through a 
network cable or FireWire. On the source computer you have Parallels Transporter Agent 
installed, while the host computer has Parallels Transporter installed. 

In the remote type of migration, you can use the following types of source computers: 

 a physical computer with a Windows or Linux operating system installed. 
 a Boot Camp partition (for using in Parallels Desktop and Parallels Server in Mac OS X) 

Before you start the migration, you need to start Parallels Transporter Agent on the source 
computer and Parallels Transporter on the host computer. Parallels Transporter Agent will 
collect data on the source computer and transfer it to Parallels Transporter running on the host 
computer. 

When migrating data from a remote Windows or Linux computer, Parallels Transporter 
transfers data from the specified volume(s) of the source computer to a newly created Parallels 
virtual hard disk (.hdd) and creates a virtual machine configuration file (.pvs). These two 
files constitute a ready-to-use virtual machine. During the remote migration, only the active 
volume is made bootable, and the resulting virtual machine has the same operating system that 
was active during the migration. If Parallels Transporter is unable to identify the source 
operating system, all source volumes are migrated as data disks. For details, see Migrating From 
a Remote Computer (p. 36). 

The process of migrating data from the Boot Camp partition of a remote Mac to a bootable 
Parallels virtual machine or Parallels virtual hard disk (p. 35) on your Mac is similar to the 
remote migration from a Windows computer. For details, see Migrating From a Boot Camp 
Partition (p. 43). 

Note: To ensure successful migration, check that your host and remote computers meet the 
system requirements (p. 9). 

Usage Tip 

If you want to experiment with the operating system or other software installed on a remote 
computer, you can use Parallels Transporter to quickly and easily migrate all source computer 
applications and data to a virtual machine on the host computer. In this scenario, you use 
Parallels Transporter Agent on your source computer to migrate data from it directly to Parallels 
Transporter on the host computer through the network or a FireWire cable. 
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Migrating Locally 
In this type of migration, you migrate data from your physical Windows or Linux computer to a 
virtual machine whose files are saved on this same computer. Then you copy the virtual 
machine files to a USB drive or other removable storage device and transfer these files 
manually to your host computer where your main application (Parallels Desktop, Parallels 
Server, or Parallels Workstation) is installed. After that you open the virtual machine files in 
your main applicationt on your host computer and work with your virtual machine. This process 
requires more time than migrating over network, but can be useful when there's no way to 
connect your PC source computer to the host computer. 

When migrating data from a Windows or Linux computer to a Parallels virtual machine or a 
Parallels virtual disk (p. 35), Parallels Transporter transfers data from the specified volume(s) of 
the source computer to a newly created Parallels virtual hard disk (.hdd) and creates a virtual 
machine configuration file (.pvs). These files constitute a virtual machine. During the 
migration, only the active volume is made bootable, and the resulting virtual machine has the 
same operating system that was active during the migration. If Parallels Transporter is unable to 
identify the source operating system, all source volumes are migrated as data disks. 

Parallels Transporter also enables you to migrate locally within the Boot Camp partition to a 
bootable Parallels virtual machine or a Parallels virtual disk (p. 35) on your Mac for using in 
Parallels Desktop or Parallels Server. The process of this migration is almost the same as the 
local migration from a Windows computer. For details, see Migrating From a Boot Camp Partition 
(p. 43). 

Note: To ensure successful migration, check that your Windows or Linux computer meets both 
the source and the host computer system requirements (p. 9). 

To migrate locally, install the Parallels Transporter package on your computer. Start Parallels 
Transporter and follow the wizard's instructions. For details, see Migrating From a Remote 
Computer Locally (p. 58). 

To migrate locally within the Boot Camp partition, you should install the Parallels Transporter 
package on the Boot Camp partition. Start Parallels Transporter and follow the wizard 
instructions. For details, see Migrating Within Boot Camp Partition (p. 54). 
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Migrating From a Boot Camp Partition 
With Parallels Transporter, you can migrate your Boot Camp partition to a bootable Parallels 
virtual machine or Parallels virtual hard disk for using in Parallels Desktop or Parallels Server 
on your Mac. There are three methods you can use when migrating from a Boot Camp partition: 

 migrating within the Boot Camp partition (local migration), or 
 migrating via the Boot Camp virtual machine, or 
 migrating from the Boot Camp partition of a remote Mac (standard remote migration). 

Migrating Within the Boot Camp Partition 

Migration within the Boot Camp partition is similar to standard local migration. In this case, 
your Boot Camp partition is considered to be an ordinary Windows computer. So, if you 
migrate within the Boot Camp partition, Parallels Transporter migrates the data from the Boot 
Camp partition to a newly created Parallels virtual hard disk (.hdd) and creates a virtual 
machine configuration file (.pvs) that are saved on the Boot Camp partition itself. The virtual 
hard disk and virtual machine configuration file constitute a virtual machine. To use this virtual 
machine with Parallels Desktop or Parallels Server, you need to copy the two files (.hdd and 
.pvs) to the host computer. 

To be able to work with the resulting virtual machine in Parallels Desktop or Parallels Server, 
you should open it in Parallels Desktop or Parallels Management Console and install Parallels 
Tools in it. For detailed information, see the user's guide of the corresponding product. 

Note: To ensure successful migration, check if your Windows Boot Camp computer meets both 
the source and the host computer system requirements (p. 9). 

To migrate according to this scenario, you need to boot into Windows OS on the Boot Camp 
partition and install the standalone Parallels Transporter package. Start Parallels Transporter and 
follow the instructions of the wizard. For details, see Migrating Within the Boot Camp Partition 
(p. 54). 

Migrating Via the Boot Camp Virtual Machine 

Migration via the Boot Camp virtual machine is almost the same as standard remote migration. 
If you migrate using the virtual machine, the Boot Camp partition is considered as a remote 
physical computer. In this case, Parallels Transporter migrates the Boot Camp partition to a 
newly created Parallels virtual disk file (.hdd) and a virtual machine configuration file (.pvs) 
on the host computer. These files constitute a ready-to-use virtual machine. 

For the information on how to create a Boot Camp virtual machine, refer to the corresponding 
sections in Parallels Desktop User's Guide. 

Note: To ensure successful migration, check if your host and source computer meet the system 
requirements (p. 9). 
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To migrate from the Boot Camp partition directly to your host computer, start your Boot Camp 
virtual machine in Parallels Desktop or Parallels Management Console and make sure that 
Parallels Transporter is installed on both computers: on the host computer and on the source 
computer (Boot Camp partition). Start Parallels Transporter on the host computer and Parallels 
Transporter Agent in your virtual machine (the source computer) and follow the wizard 
instructions. For details, see Migrating Via a Boot Camp Virtual Machine (p. 49). 

Migrating From the Boot Camp Partition of a Remote Mac 

This migration is similar to the standard remote migration. When migrating from a Boot Camp 
partition of a remote Mac, your Mac with Parallels Desktop or Parallels Server installed or 
another computer with Parallels Server or Parallels Workstation installed is considered to be the 
host computer and the Boot Camp partition of the remote Mac is considered to be the source 
computer. According to this scenario, you can migrate the Boot Camp partition into a bootable 
Parallels virtual machine and store it on your host computer. 

Note: To ensure successful migration, check if your host and remote computers meet the system 
requirements (p. 9) and network requirements (p. 16). 

To migrate from a remote Boot Camp partitionto your host computer, make sure that Parallels 
Transporter is installed on both computers: on the host computer and on the source computer 
(the Boot Camp partition of the other Mac). Start Parallels Transporter on the host computer and 
Parallels Transporter Agent in the Boot Camp partition of the source Mac and follow the wizard 
instructions. For details, see Migrating From the Boot Camp Partition of a Remote Mac (p. 44). 
 

Migrating From a Third-Party Virtual Computer 
With Parallels Transporter, you can easily migrate data from a Microsoft Virtual PC, VMware, 
or VirtualBox virtual machine or virtual hard disk to a bootable Parallels virtual machine or 
Parallels virtual hard disk. Parallels Transporter converts the third-party virtual machine files 
into the Parallels format, leaving the applications and data intact. During the migration, Parallels 
Transporter creates a virtual machine configuration file (.pvs) and virtual hard disk file 
(.hdd). These files constitute a ready-to-use virtual machine.  

When you are migrating a third-party virtual machine, Parallels Transporter may require the 
source operating system installation files to apply hardware changes to the operating system 
installed in this virtual machine. If Parallels Transporter is unable to identify the operating 
system installed in the source virtual machine or if you cannot provide the operating system 
installation files, all volumes of the source virtual machine are migrated into Parallels virtual 
hard disks (p. 35). 

You can also migrate a single Microsoft Virtual PC, VMware, or VirtualBox virtual hard disk to 
a bootable Parallels virtual machine, if the disk has an operating system installed. 

Note: Before migrating a third-party virtual machine, you need to remove virtualization utilities 
from it. For detailed information, see the Removing Third-Party Virtualization Tools (p. 74) 
section. 

To migrate from a third-party virtual machine, start Parallels Transporter on the host computer 
and follow the wizard's instructions. For details, see Migrating From a Virtual Computer (p. 64). 
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Creating Parallels Virtual Data Disks 
Parallels Transporter enables you to migrate data from physical or virtual volumes into Parallels 
virtual hard disks. After the migration, you can attach the resulting virtual disks to the existing 
Parallels virtual machines and use the data of the source volumes. The only restriction is that the 
virtual hard disk file system must be compatible with the operating system installed in the 
virtual machine. 

To create a Parallels virtual hard disk, install the Parallels Transporter package on the host 
computer and on the source physical computer, remote or host. Start the Transporter and follow 
the wizard instructions. By default, Parallels Transporter attempts to migrate the source volume 
to a virtual machine. You need to select the Advanced mode to migrate it as a data disk. For 
detailed migration instructions, see Migrating From a Remote Computer (p. 36), Migrating From a 
Remote Computer Locally (p. 58) and Migrating From a Virtual Computer (p. 64). 
 

Converting Parallels Virtual Data Disks to Virtual Machines 
You can use Parallels Transporter to migrate an already existing Parallels virtual hard disk to a 
bootable Parallels virtual machine. The virtual hard disk must have an operating system on it if 
you want to use it as primary disk of the virtual machine. Parallels Transporter will apply the 
required hardware changes to the operating system installed on the virtual hard disk to make it 
bootable in the resulting virtual machine. During the migration, Parallels Transporter creates a 
virtual machine configuration file (.pvs) for the orginal virtual hard disk file (.hdd). These 
two files constitute a ready-to-use Parallels virtual machine. 

Note: To ensure successful migration, check if your source virtual hard disk meets the system 
requirements (p. 15). 

To convert a Parallels virtual disk to a bootable virtual machine, install Parallels Transporter on 
the host computer. Start Parallels Transporter and follow the instructions of the wizard. For 
details, see Processing Parallels Virtual Disks (p. 71). 
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C H A P T E R  6  

Migrating With Parallels Transporter 
This chapter provides detailed instructions for different migration scenarios. 

In This Chapter 
Migrating From a Remote Computer .................................................................................... 36 
Migrating From a Boot Camp Partition ................................................................................ 43 
Migrating From a Remote Computer Locally....................................................................... 58 
Migrating From a Virtual Computer ..................................................................................... 64 

 
 

Migrating From a Remote Computer 
Parallels Transporter enables you to migrate from selected volumes of a remote Windows or 
Linux computer to a Parallels virtual machine or virtual disk. During migration, Parallels 
Transporter creates a virtual machine hard disk file (.hdd) and a configuration file (.pvs) and 
applies all necessary changes to the source operating system to make it bootable with Parallels 
virtual machine. 

The source and host computers must meet the system requirements (p. 15). 

Note: If you are migrating to the host Windows computer with the FAT16 or FAT32 file 
system, Parallels Transporter creates a virtual hard disk in the split format. 
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Migrating in the Express Mode 

In the Express mode, you can migrate only the active volume of a remote source computer using 
predefined settings. By default, the active volume is migrated to a bootable virtual machine. If 
an error occurs, the volume is migrated to a Parallels virtual disk (.hdd).  

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 

To migrate from a remote computer in the Express mode: 

1 Turn on the host and the source computers and log in. Make sure that the computers are 
connected by a network cable. 

2 On the source computer, start Parallels Transporter Agent by selecting Start > Program Files 
> Parallels > Parallels Transporter Agent. 

Note: While Parallels Transporter Agent is open, the Windows computer won't switch to 
sleep mode. 

3 On the host computer, start Parallels Transporter. 

To start the application on the host computer, choose Run Parallels Transporter from the Fail 
menu of the main application (Parallels Desktop, Parallels Server, or Parallels Workstation). 
If you want to start Parallels Transporter from your client computer, use third-party 
applications that will allow you to access the host computer remotely. Or you can directly 
access the host computer desktop and start Parallels Transporter. 

The Parallels Transporter wizard starts and displays the Introduction window.  

4 In the Introduction window, click Continue. 

5 In the Migration Mode window, select Express and click Continue. 

6 In the Migration Source Type window, select the entity you want to migrate. To migrate a 
remote computer to a virtual machine, select Remote physical computer and click Continue. 
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7 In the Connection Type window, specify the connection you use. Click Continue. 

Note: FireWire cannot be used for migrating from Linux remote computers. 

8 Read the checklist in the Preparing for Migration window and make sure that you are ready 
for the migration. When finished, click Continue. 

9 In the Source Computer window, choose the source computer. You can either select it from 
the source computer field or provide its IP address and connect using this data. If your 
source computer is missing from the list, click More options, select Using this IP address and 
type the source computer's IP address in the input field. Click Continue. 
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Parallels Transporter starts the migration. 

10 If Parallels Transporter can’t identify the operating system on the source volume, it will 
prompt you to specify the operating system.  

11 Parallels Transporter reads and modifies the system files to make the operating system on 
the image bootable with Parallels virtual machine. If it can’t find the necessary files, it 
prompts you to insert the installation disk or specify the path to installation files. On 
Windows, to specify the local path, click More Options and select This location. You can 
either type the path to the files (usually located in the i386 folder) or click the Choose 
button to locate the folder. 

When finished, click Continue. 

Note: If you are migrating from a Linux remote computer, go to the next step. 

 
The migration process can take a considerable time to perform. The Parallels Transporter 
icon located on the system tray indicates the status of the process. 

 - active, migration in process;   - idle, migration interrupted or completed. 

12 Parallels Transporter informs you about successful migration with the Migration Complete 
window. If you want to open the resulting virtual machine in your main application at once, 
select the Open virtual machine in <Product Name> option. Click Finish to exit the 
Transporter. 

Note: On Linux, Parallels Transporter informs you about the path to the resulting files. 

Before starting to work with your new virtual machine, open it in your main application and 
install Parallels Tools in it. For detailed information, see the user's guide of your main 
application. 
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Migrating in the Advanced Mode 

In the Advanced mode, you can select the volumes of the remote source computer that will be 
migrated and manage the migration settings. You can migrate from both active and inactive 
volumes of the computer to a Parallels virtual machine or a virtual disk. 

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 

To migrate from a remote computer in the Advanced mode: 

1 Turn on the host and the source computers and log in. Make sure that the computers are 
connected by a network cable. 

2 On the source computer, start Parallels Transporter Agent by selecting Start > Program Files 
> Parallels > Parallels Transporter Agent. 

Note: While Parallels Transporter Agent is open, the Windows computer won't switch to 
sleep mode. 

3 On the host computer, start Parallels Transporter. 

To start Parallels Transporter on the host computer, choose Run Parallels Transporter from 
the File menu of your main application (Parallels Desktop, Parallels Server, or Parallels 
Workstation). If you want to start Parallels Transporter from your client computer, use third-
party applications that will allow you to access the host computer remotely. Or you can 
directly access the host computer desktop and start Parallels Transporter. 

Parallels Transporter wizard starts and displays the Introduction window.  

4 In the Introduction window, click Continue. 

5 In the Migration Mode window, select Advanced and click Continue. 

6 In the Migration Source Type window, select the entity you want to migrate. To migrate a 
remote computer to a virtual machine, select Remote physical computer and click Continue. 
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7 In the Connection Type window, specify the connection you use. Click Continue. 

Note: FireWire cannot be used for migrating from Linux remote computers. 

8 Read the checklist in the Preparing for Migration window and make sure that you are ready 
for the migration. When finished, click Continue. 

9 In the Source Computer window, choose the source computer. You can either select it from 
the source computer field or provide its IP address and connect using this data. If your 
source computer is missing from the list, click More options, select Using this IP address and 
type the source computer's IP address in the input field. Click Continue. 

 
10 In the Source Volumes window, select the volumes you want to migrate. Click Continue. 

 If you selected an active volume with an operating system, the Hard Disk Role window 
appears. 

 If you selected an inactive volume, the Destination Folder window appears. In this case, 
go to step 13. 
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11 In the Hard Disk Role window, choose if you want to migrate to a bootable virtual machine 
or to a data disk. 

 Select Bootable disk to create a virtual machine with a bootable operating system. 

 Select Data disk to save the resulting Parallels virtual disk as a data disk. 

Click Continue. 

12 Parallels Transporter reads and modifies the system files to make the operating system on 
the image bootable with a Parallels virtual machine. If it can’t find the necessary files, it 
prompts you to insert the installation disc or specify the path to installation files. On 
Windows, to specify the local path, click More Options and select Other location. You can 
either type the path to the files (usually located in the i386 folder) or click the Choose 
button to locate the folder. 

When finished, click Apply. 

Note: If you are migrating from a Linux remote computer, go to the next step. 
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13 If you selected Bootable disk, specify the name and destination for the resulting Parallels 
virtual machine in the Virtual Machine Name window. You can manually select the place 
where your virtual disk image and virtual machine configuration file will be placed by 
clicking More Options and typing the path in the input field. 

If you selected Data disk, specify destination folder in the Destination Folder window. 

Click Continue. 

 
14 Review the specified parameters in the Migration Options window and make sure that all the 

settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

The migration process can take a considerable time to perform. The Parallels Transporter 
icon located on the system tray indicates the status of the process. 

 - active, migration in process;    - idle, migration interrupted or completed. 

15 Parallels Transporter informs you about successful migration with the Migration Complete 
window.  If you want to open the resulting virtual machine in your main application at once, 
select the Open virtual machine in <Product Name> option. Click Finish to exit the 
Transporter. Click Finish to exit Parallels Transporter. 

Note: On Linux, Parallels Transporter informs you about the path to the resulting files. 

Before starting to work with your new virtual machine, open it in your main application and 
install Parallels Tools in it. For detailed information, see the user's guide of your main 
application. 
 

Migrating From a Boot Camp Partition 
Using Parallels Transporter you can migrate your Boot Camp partition locally or remotely to a 
bootable Parallels virtual machine or Parallels virtual disk and store it either on the Boot Camp 
partition or on your host computer. 
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Migrating From the Boot Camp Partition of a Remote Mac 

Migration from the Boot Camp partition belonging to a remote Mac is much the same as a 
standard remote migration between two computers and proceeds under the same Parallels 
Transporter migration modes. 

Parallels Transporter supports two migration modes: the Express mode and the Advanced mode. 
The Express migration mode enables you to quickly convert your Boot Camp partition to a 
Parallels virtual machine and to store it in the default location of your Mac. In this mode, 
Parallels Transporter uses predefined settings, and you need to provide only the most essential 
information. The Advanced migration mode enables you to customize migration settings. 

The Express and Advanced migration modes are for the most part similar, except that when 
migrating in the Express mode, Parallels Transporter uses the default destination folder and 
doesn't prompt you to check the parameters. That is why only instructions on the Advanced 
migration are given. 

To migrate from a remote computer in the Advanced mode: 

1 Turn on the host computer and log into the source Boot Camp partition. Make sure that the 
host and source computers are connected to the same network. 

2 On the Boot Camp partition (source computer), start Parallels Transporter Agent by 
selecting Start > Program Files > Parallels > Parallels Transporter Agent. 

Note: While Parallels Transporter Agent is open, the Windows computer won't switch to 
sleep mode. 

3 On the host Mac, start Parallels Transporter. 

To start the application on a host Macintosh computer, choose File >Run Parallels 
Transporter from the main Parallels Desktop menu. If you want to start Parallels Transporter 
from your client computer, use third-party applications that will allow you to access the host 
computer remotely. Or you can directly access the host computer desktop and start Parallels 
Transporter. 

The Parallels Transporter wizard starts and displays the Introduction window.  

4 In the Introduction window of the Parallels Transporter wizard, click Continue. 

5 In the Migration Mode window, select Advanced and click Continue. 

6 In the Migration Source Type window, select the computer you want to migrate. To migrate a 
remote Boot Camp partition, select the Remote physical computer option. Click Continue. 
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7 In the Connection Type window, specify the connection you use. Click Continue. 

8 Read the checklist in the Preparing for Migration window and make sure that you are ready 
for the migration. When finished, click Continue. 

9 In the Source Computer window, choose the source computer. You can either select it from 
the source computer field or provide its IP address and connect using this data. If your 
source computer is missing from the list, click More Options, select Using this IP address and 
type the source computer IP address in the input field. Click Continue. 
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10 In the Source Volumes window, make sure that the Boot Camp partition is selected. Click 
Continue. 

Note: The Source Volumes list does not include the Mac OS partition. 
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11 In the Hard Disk Role window, choose if you want to migrate to a bootable virtual machine 
or to a data disk. 

 Select Bootable disk to create a virtual machine with a bootable operating system. 

 Select Data disk to save the resulting Parallels virtual disk as a data disk. 

Click Continue. 

12 Parallels Transporter reads and modifies the system files to make the operating system on 
the image bootable with Parallels virtual machine. If it can’t find the necessary files, it 
prompts you to insert the installation disk or specify the path to installation files. To specify 
the local path, click More Options and select This location. You can either type the path to 
the files (usually located in the i386 folder) or click the Choose button to locate the folder. 
When finished, click Continue. 
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13 If you selected Bootable disk, specify the name and destination for the resulting Parallels 
virtual machine in the Virtual Machine Name window. You can manually select the place 
where your virtual disk image and virtual machine configuration file will be placed by 
clicking More Options and typing the path in the input field. 

If you selected Data disk, specify the destination folder in the Destination Folder window. 

Click Continue. 

 
14 Review the specified parameters in the Migration Options window and make sure that all the 

settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

The migration process can take a considerable time to perform. The Parallels Transporter 
icon located on the system tray indicates the status of the process. 

 - active, migration in process;    - idle, migration interrupted or completed. 

15 Parallels Transporter informs you about a successful migration with the Migration Complete 
window. If you selected the Bootable disk option and Parallels Desktop is installed on your 
host computer, you can start working with the resulting virtual machine in Parallels Desktop 
at once by selecting the Open the virtual machine in Parallels Desktop check box. Click 
Finish to exit Parallels Transporter. 

Before starting to work with your new virtual machine, you are recommended to install Parallels 
Tools in it. For detailed information how to do it, see Parallels Desktop User's Guide. 
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Migrating via a Boot Camp Virtual Machine 

Migration via the Boot Camp virtual machine is much alike the standard remote migration and 
proceeds under the same Parallels Transporter migration modes. 

Parallels Transporter supports two migration modes: the Express mode and the Advanced mode. 
The Express migration mode enables you to quickly convert your third-party virtual machine to 
a Parallels virtual machine. In this mode, Parallels Transporter uses predefined settings, and you 
need to provide only the most essential information. The Advanced migration mode enables you 
to customize migration settings. 

The Express and Advanced migration modes are for the most part similar, except that when 
migrating in the Express mode, Parallels Transporter uses the default destination folder and 
doesn't prompt you to check the parameters. That is why only instructions on the Advanced 
migration are given. 

To migrate the Boot Camp partition to a Parallels virtual machine in the Advanced mode: 

1 Launch the Boot Camp virtual machine and make sure it is connected to the same network 
as your host computer. 

2 On the Boot Camp virtual machine (source computer), start Parallels Transporter Agent by 
selecting Start > Program Files > Parallels > Parallels Transporter Agent. 

3 On your Mac (host computer), start Parallels Transporter. 

To start the application on the Mac computer, choose File ->Run Parallels Transporter from 
the Parallels Desktop main menu. If you want to start Parallels Transporter from your client 
computer, use third-party applications that will allow you to access the host computer 
remotely. Or you can directly access the host computer desktop and start Parallels 
Transporter. 

The Parallels Transporter wizard starts and displays the Introduction window. 

4 In the Introduction window of the Parallels Transporter wizard, click Continue. 

5 In the Migration Mode window, select Advanced and click Continue. 

6 In the Migration Source Type window, select the computer you want to migrate. To migrate a 
Boot Camp virtual machine, select Remote physical computer. Click Continue. 
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7 To migrate via the virtual machine, select Network Connection. Click Continue. 

8 Read the checklist in the Preparing for Migration window and make sure that you are ready 
for the migration. When finished, click Continue. 

9 In the Source Computer window, choose the source computer. You can either select it from 
the source computer field or provide its IP address and connect using this data. If your 
source computer is missing from the list, click More options, select Using this IP address and 
type the source computer's IP address in the input field. Click Continue. 
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10 In the Source Volumes window, make sure that the Boot Camp partition is selected. Click 
Continue. 

Note: The Source Volumes list doesn't include the Mac OS partition. 
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11 In the Hard Disk Role window, choose if you want to migrate to a bootable virtual machine 
or to a data disk. 

 Select Bootable disk to create a virtual machine with a bootable operating system. 

 Select Data disk to save the resulting Parallels virtual disk as a data disk. 

Click Continue.  

12 Parallels Transporter reads and modifies the system files to make the operating system on 
the image bootable with a Parallels virtual machine. If it cannot find the necessary files, it 
prompts you to insert the installation disk or specify the path to installation files. To specify 
the local path, click More Options and select Other location. You can either type the path to 
the files (usually located in the i386 folder) or click the Choose button to locate the folder. 

When finished, click Apply. 
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13 If you selected Bootable disk, specify the name and destination for the resulting Parallels 
virtual machine in the Virtual Machine Name window. You can manually select the place 
where your virtual disk image and virtual machine configuration file will be placed by 
clicking More Options and typing the path in the input field. 

If you selected Data disk, specify the destination folder in the Destination Folder window. 

Click Continue. 

 
14 Review the specified parameters in the Migration Options window and make sure that all the 

settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

The migration process can take a considerable time to perform. The Parallels Transporter 
icon located on the system tray indicates the status of the process. 

 - active, migration in process;    - idle, migration interrupted or completed. 

15 Parallels Transporter informs you about a successful migration with the Migration Complete 
window. If you selected the Bootable disk option and Parallels Desktop is installed on your 
host computer, you can start working with the resulting virtual machine in Parallels Desktop 
at once by selecting the Open the virtual machine in Parallels Desktop check box. Click 
Finish to exit Parallels Transporter. 

Before starting to work with your new virtual machine, you are recommended to install Parallels 
Tools in it. For detailed information how to do it, see Parallels Desktop User's Guide. 
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Migrating Within the Boot Camp Partition 

Migrating within the Boot Camp partition is much the same as a local migration on a remote 
Windows computer and proceeds under the same Parallels Transporter migration modes. 

To be able to perform migration within the Boot Camp partition, you need to boot into the 
Windows OS on your Boot Camp partition and install Parallels Transporter Agent from the 
standalone Parallels Transporter package (p. 18) in it. Parallels Transporter will migrate the data 
from the Boot Camp partition to a newly created Parallels virtual machine and save its files on 
the Boot Camp partition itself. To be able to use the resulting virtual machine, you will need to 
copy its files to the host computer where Parallels Desktop, Parallels Workstation, or Parallels 
Server is installed. 

Parallels Transporter supports two migration modes: the Express mode and the Advanced mode. 
The Express migration mode enables you to quickly convert your Boot Camp partition to a 
Parallels virtual machine stored on your Boot Camp partition. In this mode, Parallels 
Transporter uses predefined settings, and you need to provide only the most essential 
information. The Advanced migration mode enables you to customize migration settings. 

The Express and Advanced migration modes are for the most part similar, except that when 
migrating in the Express mode, Parallels Transporter uses the default destination folder and 
doesn't prompt you to check the parameters. That is why only instructions on the Advanced 
migration are given. 

To locally migrate the Boot Camp partition in the Advanced mode: 

1 Boot into the Windows OS on your Boot Camp partition. 

2 Select Start > Program Files > Parallels > Parallels Transporter Agent, to start Parallels 
Transporter Agent.  

3 Select Start > Program Files > Parallels > Parallels Transporter, to start Parallels Transporter.  

4 In the Introduction window of the Parallels Transporter wizard, click Next. 
5 In the Migration Mode window, select Advanced and click Next. 
6 In the Migration Source Type window, select the computer you want to migrate from. To 

migrate your Boot Camp partition locally, select Local physical computer and click Next. 
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7 In the Source Volumes window, make sure that the Boot Camp partition is selected. Click 

Next. 

Note: The Source Volumes list does not include the Mac OS partition. 
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8 In the Hard Disk Role window, choose if you want to migrate to a bootable virtual machine 
or to a data disk. 

 Select Bootable disk to create a virtual machine with a bootable operating system. 

 Select Data disk to save the resulting Parallels virtual disk as a data disk. 

Click Next. 
9 Parallels Transporter reads and modifies the system files to make the operating system on 

the image bootable in a Parallels virtual machine. If it can’t find the necessary files, it 
prompts you to insert the installation disc or specify the path to the installation files. To 
specify the local path, click More Options and select This location. You can either type the 
path to the files (usually located in the i386 folder), or click the Browse button to locate the 
folder. 

When finished, click Next. 
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10 If you selected Bootable disk, specify the name and destination for the resulting Parallels 
virtual machine in the Virtual Machine Name window. 

If you selected Data disk, specify the destination folder in the Destination Folder window. 

Click Next. 

 
11 Review the specified parameters in the Migration Options window and make sure that all 

settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

12 Parallels Transporter informs you about successful migration with the Migration Complete 
window. Click Finish to exit Parallels Transporter. 

Note: The files of the resulting virtual machine are located on the Boot Camp partition. To 
start working with this Boot Camp virtual machine, you should first transfer the newly 
created Parallels virtual disk file (.hdd) and the virtual machine configuration file (.pvs) 
to your host computer where Parallels Desktop, Parallels Server, or Parallels Workstation is 
installed. 

Before starting to work with your new virtual machine, you are recommended to install Parallels 
Tools in it. For detailed information how to do it, see your main application user's guide. 
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Migrating From a Remote Computer Locally 
The standalone Parallels Transporter application (downloaded from the Parallels website) 
enables you to migrate from the selected volumes of a remote Windows or Linux computer 
locally to a Parallels virtual machine or virtual disk that will be stored on the same computer. 
During this migration, Parallels Transporter creates a virtual machine hard disk file (.hdd) and 
a configuration file (.pvs) and applies all the necessary changes to the source operating system 
to make it bootable with the Parallels virtual machine. 

Before you start the migration, make sure that the source Windows or Linux computer meets the 
system requirements (p. 15). 

Note: If you are migrating to the host Windows computer with the FAT16 or FAT32 file 
system, Parallels Transporter creates a virtual hard disk in the split format. 
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Migrating in the Express Mode 

In the Express mode, you can migrate all volumes of the host computer in one session using 
predefined settings. By default, the active volume is migrated to a bootable virtual machine. If 
Parallels Transporter can't identify the source operating system or you can't provide the system 
installation files, the volumes are migrated to a Parallels virtual disk (.hdd). 

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 

To migrate from the host Windows computer in the Express mode: 

1 Start Parallels Transporter Agent on your Windows computer by selecting Start > Program 
Files > Parallels > Parallels Transporter Agent. 

2 Start the standalone Parallels Transporter application on your Windows computer by 
selecting Start > Program Files > Parallels > Parallels Transporter. 

3 In the Introduction window of the Parallels Transporter wizard, click Next. 
4 In the Migration Mode window, select Express and click Next. 
5 In the Migration Source Type window, select the computer you want to migrate from. To 

migrate locally from your Windows computer, select Local physical computer and click 
Next. 
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Parallels Transporter starts the migration. 

6 Parallels Transporter reads and modifies the system files to make the operating system on 
the image bootable in Parallels virtual machine. If it can’t find the necessary files, it prompts 
you to insert the installation disc or specify the path to the installation files. On Windows, to 
specify the local path, click More Options and select This location. You can either type the 
path to the files (usually located in the i386 folder) or click the Browse button to locate the 
folder. 

When finished, click Next. 

Note: If you are migrating from a Linux host computer, go to the next step. 

 
7 Parallels Transporter informs you about successful migration with the Migration Complete 

window. Click Finish to exit Parallels Transporter. 

To start working with your new virtual machine, copy the virtual machine files to a USB drive 
or other removable storage device and transfer these files manually to your host computer. Then 
open it in your main application (Parallels Desktop, Parallels Server, or Parallels Workstation) 
and install Parallels Tools in it. For detailed information wow to install Parallels Tools, see the 
user's guide of your main application. 
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Migrating in the Advanced Mode 

In the Advanced mode, you can select the volumes of the host computer that will be migrated 
and manage the migration settings. You can migrate both active and inactive volumes of the 
host computer to a Parallels virtual machine or a virtual disk. 

The steps given here are for Windows computers. For Linux computers, the steps are mostly the 
same. 

To migrate from the host Windows computer in the Advanced mode: 

1 Start Parallels Transporter on the Windows host computer by selecting Start > Program Files 
> Parallels > Parallels Transporter. 

2 In the Introduction window, click Next. 
3 In the Migration Mode window, select Advanced and click Next. 
4 In the Migration Source Type window, select the computer you want to migrate from. To 

migrate locally from the host computer, select Local physical computer and click Next. 
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5 In the Source Volumes window, select the volumes you want to migrate. Click Next. 
 If you selected an active volume with an operating system installed, the Hardware 

Change window appears next. 

 If you selected an inactive volume, the Destination Folder window appears. In this case, 
go to step 8. 
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6 In the Hard Disk Role window, choose if you want to migrate to a bootable virtual machine 
or to a data disk. 

 Select Bootable disk to create a virtual machine with a bootable operating system. 

 Select Data disk to save the resulting Parallels virtual disk as a data disk. 

Click Next. 
7 Parallels Transporter reads and modifies the system files to make the operating system on 

the image bootable in Parallels virtual machine. If it can’t find the necessary files, it prompts 
you to insert the installation disc or specify the path to the installation files. On Windows, to 
specify the local path, click More Options and select This location. You can either type the 
path to the files (usually located in the i386 folder) or click the Browse button to locate the 
folder. 

When finished, click Next. 

Note: If you are migrating from a Linux host computer, go to the next step. 
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8 If you selected Bootable disk, specify the name and destination for the resulting Parallels 
virtual machine in the Virtual Machine Name window. 

If you selected Data disk, specify destination folder in the Destination Folder window. 

Click Next. 

 
9 Review the specified parameters in the Migration Options window and make sure that all 

settings are correct. You can go back and change them if necessary. When ready, click 
Migrate. 

10 Parallels Transporter informs you about successful migration with the Migration Complete 
window. Click Finish to exit Parallels Transporter. 

To start working with your new virtual machine, copy the virtual machine files to a USB drive 
or other removable storage device and transfer these files manually to your host computer. Then 
open it in your main application (Parallels Desktop, Parallels Server, or Parallels Workstation) 
and install Parallels Tools in it. For detailed information wow to install Parallels Tools, see the 
user's guide of your main application. 
 

Migrating From a Virtual Computer 
Parallels Transporter enables you to migrate not only from a physical computer, but also from a 
third-party virtual machine (VMware, Microsoft Virtual PC, or VirtualBox). You can migrate 
the entire virtual machine or one of its disks using the Express or Advanced migration mode as 
if it were a common  physical computer. See Migrating Entire Virtual Machine (p. 65) and 
Migrating Single Virtual Disk (p. 68) for instructions. 

Besides migrating third-party virtual disks, Parallels Transporter enables you to convert the 
existing Parallels disk image files (.hdd) into Parallels virtual machines. See Processing 
Parallels Virtual Disks (p. 71) for instructions. 
 

 



 Working With Parallels Transporter 65 
 

Migrating the Entire Virtual Machine 

Parallels Transporter migrates a third-party virtual machine by converting the third-party 
configuration file and all hard disk files into the Parallels virtual machine configuration file 
(.pvs) and hard disk files (.hdd). All data and configuration settings are preserved. 

Parallels Transporter supports two migration modes: the Express mode and the Advanced mode. 
The Express migration mode enables you to quickly convert your third-party virtual machine to 
a Parallels virtual machine. In this mode, Parallels Transporter uses predefined settings, and you 
need to provide only the most essential information. The Advanced migration mode enables you 
to customize the migration settings. 

The Express and Advanced migration modes are for the most part similar, except that when 
migrating in the Express mode, Parallels Transporter uses the default destination folder and 
doesn't prompt you to check the parameters. That is why only instructions on the Advanced 
migration are given. 

To migrate a third-party virtual machine in the Advanced mode: 

1 Copy the third-party configuration file and all hard disk files to the host computer where 
your main application (Parallels Desktop, Parallels Server, or Parallels Workstation) is 
installed. 

2 On the host computer, start Parallels Transporter. 

To start the application on the host computer, choose Run Parallels Transporter from the 
main application File menu. If you want to start Parallels Transporter from your client 
computer, use third-party applications that will allow you to access the host computer 
remotely. Or you can directly access the host computer desktop and start Parallels 
Transporter. 

The Parallels Transporter wizard starts. 

3 In the Introduction window, click Continue. 

4 In the Migration Mode window, select Advanced and click Continue. 

5 In the Migration Source Type window, choose the computer you want to migrate. To migrate 
a third-party virtual machine, select Virtual machine and click Continue. 

Note: Before migrating a third-party virtual machine, you need to remove virtualization 
utilities from it. For detailed information, see the Removing Third-Party Virtualization Tools 
(p. 74) section. 
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6 In the Migration Object window, select the migration source type. To migrate the entire 

virtual computer with all its settings and hard disk information preserved, select Entire 
virtual computer. Click Continue. 

7 In the Virtual Machine Location window, specify the virtual machine configuration file you 
want to migrate. Click the Choose button to locate the third-party virtual machine folder and 
select the necessary file. Click Continue. 

8 In the Destination Folder window, specify the folder where the new virtual machine files will 
be stored. Click Continue. 
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9 In the Migration Options window, check migration settings and make sure that all parameters 
are set correctly. You can go back and change the parameters if necessary. When finished, 
click Migrate. 

10 Parallels Transporter informs you about successful migration with the Migration Complete 
window.  If you want to open the resulting virtual machine in your main application at once, 
select the Open virtual machine in <Product Name> option. Click Finish to exit the 
Transporter. Click Finish to exit Parallels Transporter. 

Before starting to work with your new virtual machine, open it in your main application and 
install Parallels Tools in it. For detailed information, see the user's guide of your main 
application. 
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Migrating a Single Virtual Disk 

Parallels Transporter migrates a third-party virtual disk by converting the third-party hard disk 
file into a Parallels hard disk file (.hdd) and creating a new virtual machine configuration file 
(.pvs). 

Parallels Transporter supports two migration modes: the Express mode and the Advanced mode. 
The Express migration mode enables you to quickly convert your third-party virtual disk to a 
Parallels virtual machine or data disk (.hdd). In this mode, Parallels Transporter uses 
predefined settings, and you need to provide only the most essential information. The Advanced 
migration mode enables you to customize the migration settings. 

The Express and Advanced migration is mostly similar, except that when migrating in the 
Express mode, Parallels Transporter uses the default destination folder and doesn't prompt you 
to check the parameters. That is why only instructions on the Advanced migration are given. 

To migrate a third-party virtual disk in the Advanced mode: 

1 Copy the third-party hard disk file to your host computer. 

2 On the host computer, start Parallels Transporter. 

To start the application on the host computer, choose Run Parallels Transporter from the File 
menu of the main application (Parallels Desktop, Parallels Server, or Parallels Workstation). 
If you want to start Parallels Transporter from your client computer, use third-party 
applications that will allow you to access the host computer remotely. Or you can directly 
access the host computer desktop and start Parallels Transporter. 

The Parallels Transporter wizard starts. 

3 In the Introduction window, click Continue. 

4 In the Migration Mode window, select Advanced and click Continue. 

5 In the Migration Source Type window, choose the computer you want to migrate. To migrate 
a third-party virtual machine, select Virtual machine and click Continue. 

Note: Before migrating a third-party virtual machine, you need to remove virtualization 
utilities from it. For detailed information, see the Removing Third-Party Virtualization Tools 
(p. 74) section. 

6 In the Migration Object window, select the migration source type. To migrate a single virtual 
disk to a newly created virtual machine, select Virtual disk. Click Continue. 

7 In the Virtual Disk Location window, specify the virtual machine hard disk file you want to 
migrate. 

Click the Choose button to locate the third-party virtual machine folder and select the 
necessary file. Click Continue. 

8 In the Destination Folder window, specify the folder where the new virtual disk files will be 
stored. Click Migrate. 
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Parallels Transporter converts the third-party hard disk file into a Parallels virtual disk file 
(.hdd). 

9 In the Hard Disk Role window, choose if you want to create a virtual machine using the 
resulting Parallels virtual disk file as a hard disk or use it as a data disk only. 

 Select Bootable disk to create a virtual machine with a bootable operating system. 

 Select Data disk to save the resulting Parallels virtual disk as a data disk. 

10 If you chose Data disk, click Continue and then click Finish to exit Parallels Transporter. 

If you chose Bootable disk, select the operating system to make bootable in the new virtual 
machine in the Operating System Configuration window. Click Apply. 

11 Parallels Transporter reads and modifies the system files to make the operating system on an 
image bootable in a Parallels virtual machine. If it can’t find the necessary files, it prompts 
you to insert the installation disc or specify the path to the installation files. To specify the 
local path, click More Options. You can either type the path to the files or click the Choose 
button to locate the folder. 
When finished, click Apply. 

 
12 Parallels Transporter informs you about successful migration with the Migration Complete 

window.  If you want to open the resulting virtual machine in your main application at once, 
select the Open virtual machine in <Product Name> option. Click Finish to exit Parallels 
Transporter. Before starting to work with your new virtual machine, open it in your main 
application and install Parallels Tools in it. For detailed information, see the user's guide of 
your main application. 
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Processing Parallels Virtual Disks 

Parallels Transporter enables you to convert the existing Parallels disk image file (.hdd) into a 
Parallels virtual machine by creating a configuration file (.pvs) and applying the necessary 
hardware changes to the operating system on the disk image. 

Parallels Transporter supports two migration modes: the Express mode and the Advanced mode. 
In the Express mode, Parallels Transporter uses predefined settings, and you need to provide 
only the most essential information. The Advanced migration mode enables you to customize 
migration settings. 

The Express and Advanced migration is mostly similar, except that when migrating in the 
Express mode, Parallels Transporter uses the default destination folder. That is why only 
instructions on the Advanced migration are given. 

To convert a Parallels disk image into a virtual machine in the Advanced mode: 

1 Copy the Parallels disk image file to your host computer. 

2 On the host computer, start Parallels Transporter. 

To start the application on the host computer, choose Run Parallels Transporter from the File 
menu of the main application (Parallels Desktop, Parallels Server, or Parallels Workstation). 
If you want to start Parallels Transporter from your client computer, use third-party 
applications that will allow you to access the host computer remotely. Or you can directly 
access the host computer desktop and start Parallels Transporter. 

The Parallels Transporter wizard starts. 

3 In the Introduction window, click Continue. 

4 In the Migration Mode window, select Advanced. Click Continue. 

5 In the Migration Source Type window, select Virtual machine. Click Continue. 

Note: Before migrating a third-party virtual machine, you need to remove virtualization 
utilities from it. For detailed information, see the Removing Third-Party Virtualization Tools 
(p. 74) section. 
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6 In the Migration Object window, select Virtual disk. Click Continue. 

7 In the Virtual Disk Location window, specify the Parallels disk image file (.hdd) you want 
to process. 

Click the Choose button to locate the necessary file. Click Continue. 

Parallels Transporter collects information about the disk image. 

8 In the Destination Folder window, specify the resulting virtual machine destination folder. 
Click Migrate. 

You can use an external USB drive folder as a destination one. By default, the destination 
folder gets the same name as the original virtual disk. 

In the Express mode, Transporter uses the default destination folder and default name for 
the virtual machine. For more information, see Specifying Destination Folder (p. 29). 

 
9 Parallels Transporter informs you about a successful migration with the Migration Complete 

window. If you want to open the resulting virtual machine in your main application at once, 
select the Open virtual machine in <Product Name> option. Click Finish to exit Parallels 
Transporter. Before starting to work with your new virtual machine, open it in your main 
application and install Parallels Tools in it. For detailed information, see the user's guide of 
your main application. 
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C H A P T E R  7  

Troubleshooting and Limitations 

This chapter provides troubleshooting scenarios for the known issues. If you encountered an 
issue not described here, visit Parallels support team web page 
(http://www.parallels.com/en/support/desktop/) or log us a support call. 
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Removing Third-Party Virtualization Tools ......................................................................... 74 
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Reviving Applications........................................................................................................... 78
 
 

Viewing Product Information 
You can find basic product information, such as build number and trademarks, in the About 
Parallels Transporter window. To open this window, start Parallels Transporter and do the 
following: 

On Mac OS X: From the Parallels Transporter menu, choose About Parallels Transporter. 

On Windows or Linux: Right-click the title bar and choose About Parallels Transporter. 
 

Installation Problems 
If your host Windows Vista computer is not in the domain, it may refuse to restart automatically 
upon Transporter installation. In this case, you should restart it manually using the Shut Down > 
Restart command from the Windows Start menu. 
 

 

http://www.parallels.com/en/support/desktop/
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Removing Third-Party Virtualization 
Tools 

Before migrating a third-party virtual machine, you need to remove virtualization utilities from 
it. Each of the supported third-party virtualization products has its own set of virtualization 
tools: 

 In VMware virtual machines, it is VMware Tools. 
 In Microsoft Virtual PC virtual machines, it is Virtual Machine Additions. 
 In VirtualBox virtual machines, it is VirtualBox Guest Additions. 

The procedure of removing these virtualization tools depends on the virtualization product and 
the guest operating system installed in your virtual machine. 

Removing virtualization tools from Windows virtual machines 

In a Windows virtual machine of either third-party virtualization product, you can remove 
virtualization tools using the standard procedure: 

1 Open the virtual machine in the application you used to run it. 

2 Log on the guest operating system as Administrator or a member of the Administrators 
group. 

3 In the Start menu, select Control Panel > Add or Remove Programs. 

4 Select the corresponding virtualization tools name and click Remove. 

Removing Vmware Tools from Linux virtual machines 

To remove VMware Tools in a Linux virtual machine, perform the following actions: 

1 Open the virtual machine in the application you used to run it. 

2 Log on the guest operating system. 

3 Start a terminal and type the following command to gain the root privileges: 
su 

4 To find out the build number of the VMware Tools package, enter the following: 
rpm -qa |grep VMware 

This command returns you the package name and build number. 

5 Remove VMware Tools by entering 
rpm -e VMware-Tools-xxx 

Use the build number found above instead of xxx. 

For detailed information on removing virtualization tools, see the corresponding product 
documentation. 
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Firewall Settings 
Firewall applications may block the connection between Parallels Transporter and Parallels 
Transporter Agent. 

Firewall problems in Mac OS X 

If Parallels Transporter fails to find Parallels Transporter Agent, it is most likely that built-in 
Mac Firewall blocks the connection with Parallels Transporter Agent. 

To  enable the connection between Parallels Transporter and Parallels Transporter Agent and 
prevent further blocking, you should either turn off Firewall or add Transporter and Transporter 
Agent to the Firewall exceptions: 

1 From the Apple menu, choose System Preferences and select Sharing. 

2 In the Sharing window, choose the Firewall tab. 

3 Change the necessary settings. 

4 Now you can proceed with migration.  

If you try to search for Parallels Transporter Agent by typing the source computer IP-address 
manually, you will receive the message saying that Parallels Transporter Agent is being 
blocked. Click the Unblock button to enable the connection between Parallels Transporter and 
Parallels Transporter Agent. 

Firewall problems in Windows 

Microsoft Windows XP and Microsoft Windows Vista have a built-in firewall that blocks 
connections from and to other computers. When starting Parallels Transporter or Transporter 
Agent for the fist time, you may get the following message:   
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Click the Unblock button to enable the connection between Parallels Transporter and Parallels 
Transporter Agent. 

To prevent future blocking, add Transporter and Transporter Agent to the Firewall exceptions 
(the list of applications allowed to communicate through Firewall): 

1 From the Start menu, choose Control Panel > Network Connections. 

2 In the Network Tasks pane, click Change Windows Firewall Settings. 

3 Add Parallels Transporter and Transporter Agent to the Firewall exceptions list. 
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Migration Errors 
This section provides solutions to some errors that may occur during the migration process. 

Parallels Transporter does not work correctly 

If you try to migrate a remote Windows computer and experience problems, make sure that the 
snapman.sys driver is installed in C:\WINDOWS\system32\drivers\ . 

If the snapman.sys driver is not installed, follow these steps: 

1 Uninstall Parallels Transporter Agent. 

2 Restart your source Windows computer. 

3 Reinstall Parallels Transporter Agent. 

4 Restart your source Windows computer again. 

5 Ensure that Parallels Transporter and Parallels Transporter Agent run properly, and try to 
migrate the source computer again. 

Migration is interrupted by an error 

If migration from a source Windows computer was interrupted by an error, do the following 
before trying to migrate again: 

1 From the Start menu, choose My Computer. 
2 On the Hard Disk Drives pane, select the volume from which you want to migrate. Right-

click the volume and choose Properties.  

3 In the Properties pane, click the Tools tab and in the Error Checking section click the Check 
Now button.  

4 In the Check Disk window, select both options: Automatically fix file system errors and Scan 
for and attempt recovery of bad sectors. Click Start. 

5 Wait until the disk is scanned and errors are fixed. 

Dynamic volumes are not migrated 

Only basic volumes can be migrated. You cannot migrate dynamic volumes with Parallels 
Transporter. 

The only way to migrate the data stored on a dynamic disk is to copy this data to a basic disk on 
the host computer, and then to migrate this basic disk. 
 

Activation Problems 
If you migrate from Windows volumes to a bootable Parallels virtual machine, the operating 
system detects that the hardware changed and may require reactivation. 
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Reviving Applications 
Applications that severely depend on specific hardware may not work in a virtual machine, 
because virtual machine hardware is different from hardware used on a source computer. 

If you migrated from several source volumes, the disk drive letters were changed. Make sure 
that the application paths are set correctly. If not, update them and see if the application works. 
If this didn't help, contact Parallels support http://www.parallels.com/en/support/. 
 

 

http://www.parallels.com/en/support/
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Glossary 

This glossary defines terms and spells out abbreviations used in this guide. References to terms 
defined elsewhere in the glossary appear in italics. 

Administrator. A user with administration privileges. 

Active volume. The volume of the physical source computer that is used as a boot volume for the 
source computer operating system.  

Bootable hard disk. A disk used by the operating system to boot from, usually a disk that has an 
operating system installed. 

Boot Volume. A hard disk partition from which the operating system boots. 

Boot Camp partition. A partition on the hard disk of the host computer that can be used for 
installing a Windows operating system on it (for Mac host computers only). 

Configuration file. A file specifies the virtual machine's hardware configuration, the devices it 
uses, and other settings. It is created automatically when you create a new virtual machine. See 
also PVS file.  

Disks in the old format. Disks of virtual machines that were created in Parallels Desktop 2.5 and 
earlier or Parallels Workstation 2.2. 

Disks in the new format. Disks of virtual machines that were created or used in Parallels Desktop 
3.0 and 4 or Parallels Workstation 4.0. 

Expanding format. A virtual hard disk format. An expanding virtual hard disk image file resides 
on your host computer and is small initially. Its size grows as you add applications and data to 
the virtual machine. 

FireWire connection. A wired connection that enables a high-speed data transmission between 
computers. 

Guest operating system (guest OS). An operating system installed inside your virtual machine. 

Host computer: The computer that is used to run virtual machines. In case of Parallels Desktop, 
it is your Mac. In case of Parallels Workstation, it is the Windows or Linux physical computer 
where Parallels Workstation is installed. In the Parallels Transporter documentation, this term 
may define the computer that hosts the result of migration. 

HDD file. During the creation, the virtual machine acquires a virtual hard disk file with the .hdd 
extension. See also virtual hard disk file. 

ISO Image. A special file that contains the entire contents of a CD or DVD disc commonly used 
to install an operating system. 
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Image file. A single file containing the complete contents and structure of a data storage medium 
or device, such as a hard disk drive, CD, or DVD. 

Linux computer. A physical computer that has a Linux operating system installed. 

Main application (product). The Parallels Virtualization product that you use on your host 
computer. It can be either Parallels Desktop or Parallels Workstation or Parallels Server. 

Merged disk. A split disk whose parts were merged into a single disk. 

Migration. The process of transferring data from a physical computer or a third-party virtual 
machine into a Parallels virtual machine or virtual disk. 

OS. An operating system. 

Parallels Desktop.  An application that enables you to create, manage, and use virtual machines 
on your Mac. 

Parallels Explorer. An application that enables you to browse and manage the contents of your 
virtual machines without starting them. 

Parallels Image Tool. An application that enables you to manage the capacity and properties of 
your virtual machine's hard disk.  

Parallels Mounter. An application that enables you to to browse the contents of your virtual 
machines and virtual hard disks directly in Mac OS X Finder. 

Parallels Tools. A set of Parallels utilities that ensures a high level of integration between the 
primary and the guest operating systems. 

Parallels Transporter. An application that uses data of a physical or virtual computer for creating 
a Parallels virtual clone of this physical or virtual computer. The resulting virtual machines can 
be used with the main application. 

Parallels Transporter Agent. An application that collects data on a physical computer and 
transfers it to Parallels Transporter installed on the host computer. 

Parallels Workstation. An application that enables you to create, manage, and use virtual 
machines on a Windows or Linux computer. 

Plain format. A virtual hard disk format. A plain virtual hard disk image file resides on the host 
computer and has a fixed size that cannot be changed. 

Primary operating system (primary OS). Operating system that controls the I/O devices of the 
computer and that is loaded when the physical computer is turned on. It is the operating system 
of the physical computer where the main application is installed. 

PVS file. A virtual machine configuration file that contains information about the virtual 
machine resources, devices and other settings. 

Shortcut. A user-defined key or combination of keys that provides quick access to applications 
and commands. See also Hot key. 
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Snapshot. A copy of the virtual machine state at a particular point of time. The files related to 
snapshots are stored in a special subfolder in the virtual machine's folder. 

Source computer or source operating system: The computer that you are going to migrate data 
from. On physical source computers, Parallels Transporter Agent should be installed. 

System disk. A floppy disk that allows your computer to load the operating system. 

Split disk. A split disk is cut into 2 GB pieces, but is stored as a single HDD file. Split disks 
allow you to transfer the data stored on a split disk piece by piece using a USB drive or other 
media that have limited space and cannot store a large virtual hard disk image file. 

Virtual hard disk (virtual disk). A file or group of files that emulates the virtual machine's hard 
disk. 

Virtual machine. The computer emulated using Parallels Desktop, Parallels Server, or Parallels 
Desktop. A virtual machine has its own virtual hardware and requires an operating system to 
control its hardware. The installed operating system and its applications are isolated inside the 
virtual machine and share physical hardware resources of the host computer. 

Third-party virtual machine. A virtual machine created in a third-party virtualization product, that 
can be converted to Parallels virtual machines with the help of Parallels Transporter. 

Virtual Machine Configuration. Like any physical computer, a virtual machine has it's own 
configuration which is set during the creation and can be later modified. The virtual machine 
configuration settings are stored in a PVS file. 

Virtual machine files. Files stored in a virtual machine folder. A virtual machine has at least two 
files: configuration file and virtual hard disk file. 

Virtual hard disk file. During the creation, the virtual machine acquires a virtual hard disk file 
with the .hdd extension. This file performs the functions of a real hard disk. See also HDD file. 

Virtual machine template. A virtual machine that can be cloned to multiple virtual machines that 
will have the same configuration and data that the virtual machine template had. 

VM. See Virtual Machine. 

Windows computer. A physical computer that has a Windows operating system installed. 
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